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Welcome to this (unofficial) step-by-step guide to Zotero! 

In this document, you’ll learn many new tips for using Zotero, ranging from the 
fundamentals to advanced integrations, and discover the myriad ways Zotero 

can benefit, enhance and streamline your research.  

This guide was originally compiled for a D/ARC workshop, designed for 
graduate students working in internet studies. However, researchers from all 

fields and levels of study will hopefully find this guide useful.

A huge thanks to PS Berge for their beautiful slide design and input; and to the
Zotero community for creating and maintaining such a comprehensive online 

directory on how to make the most of this incredibly powerful software.

Whether you’re just about to embark on your Zotero journey or are looking to 
level up after years of use, I hope this document proves an illuminating and 

useful companion!

- Rachel Berryman
May 2022

Hi there! 👋

This document incorporates information from the Zotero Support 
Wiki, which is licensed under Creative Commons Attribution-
ShareAlike 4.0 International License (CC-BY-SA 4.0).

This work is also licensed under a Creative Commons Attribution-
ShareAlike 4.0 International License.

https://psberge.com/
https://www.zotero.org/support/
https://www.zotero.org/support/
http://creativecommons.org/licenses/by-sa/4.0/
http://creativecommons.org/licenses/by-sa/4.0/


The Discord Academic Research Network (affectionately known as 

the D/ARC) is an inclusive and supportive network of 300+ researchers 

interested in Discord communities, platforms, and cultures. 

Our mission is to:

create & share 
new tools and resources for Discord researchers

track & promote
new research on Discord and opportunities for members

empower & unify 
our community through networking and collaboration

Darcmode.org/invite
Join us in the Discord server!



Zotero is a free, open-source citation manager which 

radically streamlines the process of collecting, 

organizing, citing and sharing research.

It was created in 2006 by an independent, nonprofit 

group, and is continually updated and refined to suit 

the needs of its community of researchers. 

The three basic components of Zotero are the desktop 

application (which automatically includes the word 

processor plug-in), and the browser extension.

overview

what is zotero?

Zotero.org/download

You can download the Zotero desktop 
application and browser extension at

Rachel Berryman
@channelera

https://www.zotero.org/support/credits_and_acknowledgments


• Uses a quick citation search functionality for minimal disruptions while writing

• Generates a fully-formatted bibliography for all of the citations embedded in 
your document in just one click

• Includes support for over 10,000 citation styles, drastically reducing the time 
spent manually formatting and cross-checking style guides

• Allows you to instantly and effortlessly update in-text citations to a different 
referencing style at any time during the writing process

• Built with browser extensions that import websites, academic articles and PDFs 
into your library in seconds

highlights

How will zotero improve my life?
Radical

ly!

Rachel Berryman
@channelera



Before we begin

GETTING STARTED
• You don’t need an account to use Zotero: once you download it, 

it runs locally on your computer
• However, creating an account is best practice if you want to save 

and back-up your library. You can create one here.

• With a (free!) account, Zotero saves and synchronizes your library 
across devices, making it accessible from anywhere

(You also get access to more sophisticated and collaborative 
features, like shared libraries and user profiles!)

Rachel Berryman
@channelera

http://zotero.org/user/register


navigating the interface
Start here

Although the Zotero interface can seem intimidating, its features are more straightforward than you might think. 

You don’t need to memorise all of its secrets, but it’s worth familiarising yourself with its basic functionalities!



Library Pane
Organises items using 
Collections (folders). The 
“My Library” collection at 
the top of this pane 
contains all of the items in 
your library. The current 
view shows a Group 
Collection, filled with many
sub-collections. You can 
drag and drop a source to 
copy it into a new 
Collection.

Create a New 
Collection

Tags Pane
All items can be given tags 
by the user. The tags for all 
items in the current library 
view are shown here, 
allowing you to sort and 
view all entries by specific 
tags or combinations. 
You can right click a tag to 
rename or remove it.

Quick Search
Find an entry by 
title, keyword, 
author, tag, etc.

Advanced Search
For complex search 
queries, multiple and 
dynamic conditions

Create a New Group
A library that can be shared 
or accessed by others

Item Metadata
This is where you can view, 
update and add additional 
details about the metadata 
for each of your items  - it is 
the information that Zotero 
will use when creating your 
bibliography. 

The metadata fields change 
by Item Type, which you 
can change by clicking on 
this field, and opening the 
drop-down menu. 

You should always double-
check the the details that 
appear here are accurate, 
in case they have imported 
incorrectly. 

Zotero 6 preview shown. Find out more at https://www.zotero.org/support/quick_start_guide

Create a 
Note for 
Your Item

Tag Your Item

Add a New Item
Start by selecting the 
Item Type (book, 
book section, article, 
website, etc.)

Citation 
Wizard

Create a New Note 
Either standalone, or to 
attach to one of your 
existing items

Sync Library with 
Zotero.org

Tag Search

Window 
Tabs

To Adjust Your View
- Use + and – (on keyboard) to 
expand or minimize all entries

- Right click the “Title” header 
to select/adjust visible columns

Rachel Berryman
@channelera

https://www.zotero.org/support/quick_start_guide


CREATING YOUR LIBRARY
STEP ONE

There are four main methods for adding sources to your Zotero library: 

The Manual Method, Add by Identifier (aka “Citation Wizard”), Drag’n’Drop, and the Browser Extension.



Adding sources

1. Manual method

STEP ONE

Use the “New Item” button 

(green plus), or File > New 

Item to select the Item 

Type you want to import.

Items can be anything 

from books, articles, and 

reports to web pages, 

artwork, manuscripts, 

films, or recordings.

STEP TWO

In the Item Pane on the right 

hand side, manually enter key 

information about your item –

e.g. title, author/s, date of 

publication, journal or book 

name, page no., URL, etc.

Right click the Author’s 
name or click this box to 
swap or change the order 
of the names (last, first; 
first, last; full name)

Use the + or - to add or subtract 
spaces for author info, or press 
Shift+Enter as you’re typing namesClick on “Author” 

to select a 
different role for 
each contributor 
(e.g. editor, 
director, 
translator)

Click on “Journal 
Article” to change 
the Item Type.

Rachel Berryman
@channelera



Adding sources

1. Manual method

OPTIONAL STEP THREE

One of Zotero’s most helpful features is the ability to 

internally store documents corresponding to each 

item in your library. To add an attachment (e.g. a PDF 

of a journal article or book chapter, or a relevant URL), 

click the Add Attachment (paperclip) button, or right 

click the entry and select “Add Attachment”. 

Alternatively, drag the file from your My Documents or 

Finder window, and drop it onto the relevant item.

Rachel Berryman
@channelera



TIPS & TRICKS

enhancing your metadata
TO RE-FORMAT TITLES

Simply right-click on the Title or Publication field to easily change the 

capitalisation to Title Case or Sentence Case.

TO INCLUDE DETAILS OF A RE-PRINTED WORK

For older (often foundational) sources that have been re-printed in books 

or journals, etc., you can use a macro in the Extra field to ensure that the 

original date is included in in-text citations and bibliographies.

e.g. Including “original-date: 1970” in the Extra field will transform the 

2012 reprint of Masahiro Mori’s classic theorisation of the Uncanny Valley 

to a citation and bibliographic entry with both dates: (Mori, 1970/2012).

Rachel Berryman
@channelera



TIPS & TRICKS

source PDFs for your citations
Zotero’s partnership with Unpaywall, an expansive (legal!) database 

of full-text articles, gives you the ability to source PDFs for items in 

your Library without leaving Zotero. There are two ways of leveraging 

this integration:

• Add By Identifier/Citation Wizard

Items added by identifier (e.g. DOI, ISBN) will automatically be 

searched for PDFs to download before looking for OA copies

• Add for Existing Citation

Right click citation > Select “Find Available PDF” to search

Read Zotero’s blog about this partnership here.

Rachel Berryman
@channelera

https://www.zotero.org/blog/improved-pdf-retrieval-with-unpaywall-integration/


Adding sources

2. citation wizard & 3. DRAG’N’DROP

CITATION WIZARD

If you have an item’s DOI or ISBN number, you can use 

the magic wand button (“Add Items by Identifier”) to 

automatically retrieve all of the associated metadata 

and add the item to your library.

DRAG’N’DROP

Drag and drop a downloaded file (e.g. PDF) from your 

computer’s Finder, Documents or Downloads into clear 

space in your library – Zotero will scan the document’s 

metadata and generate an entry for it automatically!

To save yourself time, there are two methods of adding sources that make Zotero do the heavy-lifting:

Rachel Berryman
@channelera



troubleshooting

drag’n’drop

If a parent entry doesn’t automatically appear when adding a local file 

attachment into your library via Drag & Drop:

• Right click the attachment >

• Click “Create Parent Item” >

• Add the item’s DOI or ISBN, or create a manual entry for it >

✅ The attachment will be paired with the item details

To use Drag & Drop in a densely populated library (where there is no clear, white space), when dragging 

the attachment into your library, point your cursor between entries - a thicker grey line will appear to show 

you are creating a new entry, rather than attaching your document to an existing item.

Rachel Berryman
@channelera



After installing the Connector to your browser, a Zotero icon will 
appear in your browser toolbar. 

To add a webpage to your library, wait until the icon changes from 
a blank grey web page (‘loading’) to reflect the type of source you’re 
wanting to include (e.g. article, web recording, etc.).

When you click on the icon, a small grey window will appear (pictured 
top right), showing Zotero’s progress saving the entry to your library.

Clicking on the drop-down arrow will open a mini view of your 
library. By default, new sources will  save to the collection you are 
currently viewing in your Zotero window, but you can use this pane to 
select another Collection to file your source in, and to easily add tags, 
without leaving your browser session.

Adding sources

4. The        browser extension

(You can navigate back to this window after 
adding the source to your library by clicking on 
the Zotero Icon in your browser toolbar again)

Rachel Berryman
@channelera

http://www.zotero.org/download


TIPS & TRICKS

Adding books from 
your browser
You can also use the Zotero browser extension to easily add 

relevant book/print sources to your library by viewing their 

entries on a catalogue, such as:

- Google Books

- Amazon Books

- A publisher’s website

- Your institution’s library

Zotero will identify the page source as a book, and index all of 

the metadata that the website has collated about it - importing 

it all to your library when you click the Zotero icon.

Photo by Kimberly Farmer on Unsplash

Rachel Berryman
@channelera

https://unsplash.com/@kimberlyfarmer
https://unsplash.com/


TIPS & TRICKS

Archiving the 
internet
As well as identifying more traditional sources to import into 

your library (e.g. journal articles, books, etc.), the Zotero 

browser extension allows you to import web pages. Not 

only does it scrape metadata from a web-page, including 

author name and date (e.g. for blog posts or news articles), 

it also takes a snapshot of the web page to store alongside 

the item in your library, effectively turning your Zotero into 

a personal web archive. 

Photo by C M on Unsplash

Rachel Berryman
@channelera

https://unsplash.com/@ubahnverleih
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TIPS & TRICKS

RETRACTION  NOTIFICATIONS
Zotero partners with Retraction Watch, which 

maintains the largest database of retractions 

available, to automatically flag retracted 

publications in your library, keeping you 

updated about the status and legitimacy of all 

of your sources.

You can read Zotero’s blog announcement here. Photo Credit: 
Dan Stillman (2019)

Rachel Berryman
@channelera
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Organising your library
STEP two

Just as everyone has their own style for organising the files on their desktop, each user will have their own 

preference for how to organise their Zotero library! We’ve included some basic pointers to get you started.



Organising your library

Create a collection

Use Collections (and sub-

Collections!) to group your 

items by project, section or 

chapter, concept or status.

Create a new Collection by 

clicking the Yellow File icon 

in the top left-hand corner.

Items can exist in multiple 

collections at once. 

To add an item to another 

collection, simply drag and 

drop it from the centre 

column to a collection in the 

Library Pane. (This helps to 

avoid duplicate entries!)

View which folders an entry 

is currently in by holding 

down Option (Mac), Control 

(Windows), or Alt (Linux).

Rachel Berryman
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Organising your library

CLASSIFY YOUR ITEMS with tags

Use tags to categorise, describe and filter items in your library, 

surfacing relevant concepts and keywords at a glance. Tags 

will sometimes be imported from a document (orange), but 

can also be manually amended, deleted and added (blue).

Tags for all items in the current library view are shown in 

the tag selector pane, located at the bottom left corner of 

the Zotero window, allowing you to sort and filter entries 

by clicking on specific tags (or combinations thereof).

Rachel Berryman
@channelera



TIPS & TRICKS

COLOUR-CODING tags

You can assign colours to up to 9 tags per library. 

This allows you to visually code particular entries, 

with small boxes appearing next to the name of 

your entry. You can even include emojis to 

your tags to make things sparkle! 
✨

Helpful hero tags might include codes, themes, 

or progress (e.g. To Read, To Source).

Rachel Berryman
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troubleshooting

Cleaning up your tags
Zotero tags are case sensitive, and do not account for synonyms or 

small variances (e.g. ”webpage” vs. “website”). Similar tags can be 

manually merged by renaming one to the name of the other:

• Right click the tag in the tag selector  >

• Select “Rename Tag…”

• Enter the name of the matching tag > tags will be merged!

To bulk assign a tag to multiple items, select the items in the main 

pane, then drag them onto the tag in the tag selector. Voila!

Rachel Berryman
@channelera



troubleshooting

MERGING DUPLICATE ITEMS
It’s best to avoid duplicate items in your library, so you don’t end up 

with multiple versions of the same item in your bibliography.

To clean up your library, head to the Duplicates section at the 

bottom of your Library view. Select a duplicate entry to get started.

• Use the selection box to switch between the details of the two 

(or more) items, and choose your preferred ‘base’ entry.

• Use the “Decision Tree” icon to view additional/divergent fields 

between the entries. Select the option you’d like to use, or 

leave blank

NB: If Zotero has misidentified two items as duplicates, you don’t have to merge them –

just leave them there! Also, when merged, attachments will automatically be included.

Switch 
between 
items

Check divergent fields 
between items, select 
preferred option

Click to 
merge 
when 
complete

Rachel Berryman
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Organising YOUR LIBRARY

Notes & pdf annotations
Use Notes to annotate entries with 

(searchable) summaries, thoughts, and 

relevant quotes. 

Use the “Aa” button to format your 

text, and the [+] button to add a 

citation to another item in your library.

You can directly import Notes into a 

word document using the button in 

the Word Processor plug-in menu.

Zotero comes with an in-built PDF viewer, allowing you 

to highlight and comment on your documents, and 

expand them into detailed Notes. Any amendments 

you make to the file are saved to the local version of the

document in your Zotero library.

Rachel Berryman
@channelera



Organising your library

Removing or deleting ITEMS

DELETE AN ITEM FROM YOUR LIBRARY

Right click an item and select “Move to Trash” to delete 

it from your library - this removes the file from all the 

collections it’s currently in, and moves it to the Trash 

folder.

REMOVE  FROM (JUST A) COLLECTION

If you mis-assign an item, or decide it’s not relevant for 

a particular collection, simply right click the source and 

click “Remove Item from Collection…”. This will keep 

all of its other location assignments in-tact.

Rachel Berryman
@channelera



TIPS & TRICKS

advanced searches & SAVED SEARCHES
Zotero’s Advanced Search feature enables more complex search 

queries for items in your library. For example, you can restrict 

searches to find keywords in particular fields (abstract, tags, title, 

items), search only in particular Collections, and overlay multiple 

conditions to locate narrower sets of results. 

You can also save Advanced Searches to your Library panel. 

Saved Searches are similar to Collections, but will update with new 

matching items automatically - useful for keeping track of items 

with particular qualities (e.g. certain keywords, in a certain date 

range, or by a particular author, etc.). To save a search, enter your 

filters and click Save Search.

For more Advanced Search support, visit here. 

Save your 
Search

Advanced 
Search icon

Add and 
remove 

additional 
search 

parameters

Mandate an ‘and’ (all) 
or ‘or’ (any) query

Rachel Berryman
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Exporting your library
Step three

Whether recommending a reading to a friend or generating a fully-formatted annotated bibliography, there 

are many several to share details about the items in your Zotero library with others.



Exporting your library

Quick methods for exporting
GENERATE A CITATION

Right click your item/s and 

select “Create Bibliography 

from Item…”. Choose a 

citation style and select “Copy 

to Clipboard”. Alternatively, 

select your items, then head 

to Edit > Copy Bibliography. 

You’ll now be able to paste 

formatted citations anywhere!

GENERATE A FULL REPORT

Right click your citation/s and 

select “Create Report from 

Item…”. Zotero will generate 

a .pdf “report” of all of the 

bibliographic information of 

the entry (incl. abstract and all 

of its metadata), useful for 

annotated bibliographies, etc.

Rachel Berryman
@channelera



TIPS & TRICKS

MOVING BETWEEN WORD PROCESSORS
Zotero lets you move documents between Google Docs and 

Word or LibreOffice, while preserving active Zotero citations –

very helpful if you and your collaborators or supervisors 

prefer different word processors!

Instructions follow the same general process:

• Choose “Switch to a Different Word Processor…” 

from the Zotero plugin’s Document Preferences

• Save the converted file

• Open the file in the other word processor

• Click Refresh to continue using it

Rachel Berryman
@channelera
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WRITING AND CITING
Step FOUR

Zotero’s word processor integration and citation tools enable you to easily locate, 

format and cite sources while you’re writing.



Writing and Citing

ADDING YOUR FIRST CITATION
When you’re ready to add a citation, navigate to the Zotero tab in your word processor toolbar, and click 

the “Add/Edit Citation” button. Clicking this in a new document will open a window where you can select 

your preferred citation style – once confirmed, the red Quick Cite window will appear. 

In the Quick Cite window, use a keyword from the item’s title, or an author name to locate your item. Use 

“Omit author” to only insert the year of publication (and page no., if needed), for example, for in-text 

citations such as “Jenkins (2004) observes...”.

REMEMBER:

• If you change/update an item in your Zotero library, use the “Refresh” button to reflect the changes in 

your working document.

• You can change your document’s citation style at any time via “Document Preferences”.

• At the end of your project, simply click “Add/Edit Bibliography” to automatically generate a bibliography 

including all of your in-text citations. (Remember to check for formatting errors and duplicates!)

Rachel Berryman
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Writing and Citing

AMENDING YOUR CITATIONS
To add extra details to your in-text citations using the Quick Cite window, see the instructions below: 

Type a number before pressing Enter when selecting 

your citation to add a page number to your citation. 

Or, click the entry and type the page number in the 

Page field.

Use the Prefix field to add extra details to the 

beginning of your citation parenthesis.

Use the Suffix field for items with no page number, 

inserting “, n.p.” to connect it to the previous citation.

Rachel Berryman
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Writing and Citing

AMENDING YOUR CITATIONS
To add extra details to your in-text citations using the Quick Cite window, see the instructions below: 

Click the Page button to choose a different unit to cite.

Citations will automatically load in alphabetical order, but there 

may be times that you need to circumvent this, for example, if 

adding a reference to an in-text quote, and then linking to other 

relevant sources. In this case, you can drag to manually rearrange 

the citations to the order you prefer, and delineate further 

readings by adding text such as “; see also,” to the Prefix of 

subsequent references.

Use the light-grey sub-headings to locate references previously 

Cited (avoiding duplicate entries), and to navigate to the correct 

citation via their location in your Collections. 

Rachel Berryman
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troubleshooting

THE WORD PROCESSOR PLUG-IN
The word processor plug-in should install automatically with your 

Zotero desktop application, and will appear as a new tab in your 

word processor menu bar. (You will need to restart your word 

processor for it to appear!)

If this doesn’t happen, you can troubleshoot by (re-)downloading 

the word processor plug-in alone. In Zotero, go to Preferences > 

Cite > Word Processors, and download your preferred extension.

Read the full Zotero documentation on this here. 

Rachel Berryman
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Extras for experts
Mastering zotero



Extras for  experts

USING shared libraries

Once you’ve registered for 

a Zotero account, you’ll be 

able to access Shared 

Libraries. You can create 

or join a shared library, 

which can be public or 

private. They’re perfect for 

co-authors, students or 

interest groups.

You can also download the D/ARC Zotero 
library at darcmode.org/zotero!

Rachel Berryman
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Extras for  experts

Experiment with new plug-ins

For Systematic Literature Reviews or Meta-Analyses

• Zotero Citation Counts Manager by Emiliano Heyns
• Look up citation counts from Crossref, Inspire HEP, NASA/ADS, and Semantic Scholar.

• Google Scholar Citations for Zotero by Anton Beloglazov, currently maintained by Max Kuehn 

• Add Google Scholar citation counts to items in your Zotero library.
• Use the Timeline feature in Zotero tools, to visualise entries over time.

Photo by  Green Chameleon on Unsplash
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Extras for  experts

Experiment with new plug-ins

For Library Visits

• Barcode scanner for iOS by Zotero

• Add physical books to Zotero by scanning their barcodes with your iPhone or iPad

• Save ISBN for Android (web) by Zotero

• Bookmark this page on your mobile browser - type in a book’s ISBN to save it to your 
library while you’re away from your computer

Photo by Shunya Koide on Unsplash
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Extras for  experts

Experiment with new plug-ins

With Other Amazing Software

• Notero by David Vanoni

• Sync items from your 
Zotero library into Notion

Browse the full plug-in range

Zotero.org/support/plugins

Photo Credit: PS Berge

Rachel Berryman
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FREQUENTLY ASKED Q’S
miscellaneous



FREQUENTLY ASKED Q’S
HOW CAN I USE ZOTERO TO CITE SOCIAL MEDIA 
CONTENT (E.G. INSTAGRAM POSTS, YOUTUBE VIDEOS)?

Item Type: Video Recording

Contributor Type: Director

(for Channel/Acct Name)

Use direct URL

Library Catalogue: YouTube/TikTok

Item Type: Blog Post

Title: Full Tweet Text

Contributor Type: Author 

Use direct URL

Website Type: Tweet

Although Zotero doesn’t currently have Item Types for citing content from specific social 
media platforms, I’d recommend adapting the below citation presets to suit:

Item Type: Web Page

Contributor Type: Author 

Website Title:

Instagram/Tumblr

Use direct URL

Rachel Berryman
@channelera



FREQUENTLY ASKED Q’S
I’M SUBMITTING TO A conference or JOURNAL THAT 
HAS THEIR OWN REFERENCING STYLE. HOW CAN I 
FORMAT MY DRAFT TO ALIGN WITH THEIR UNIQUE 
STYLE & SPECIFICATIONS?
Zotero supports over 10,000 different referencing styles, so it’s highly likely you’ll be able to 
find a style someone’s already made for this exact reason! 

You can search for different styles here, then simply click on the one you’d like to download: 
https://www.zotero.org/styles

If you’re still not able to find what you’re looking for, you can use this handy tool: Citation Style. 
On the “Search by Example” page, you can paste an example of your desired referencing format 
(e.g. a bibliographic entry from the journal style guide), and Citation Style will automatically 
show you all the other styles that closely match the one you’re looking for!

Even better, CS allows you to edit any small tweaks you may still need to make to get the 
formatting just right – you can then download it to use in Zotero! Amazing!

Rachel Berryman
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FREQUENTLY ASKED Q’S
Wow, i’m so keen to try zotero! But i’ve used a 
different referencing approach in the past… 
how can I easily import all of my references?

You can find a 

guide for how to 

import your 

EndNote library 

into Zotero here.

You can find a 

guide for how to 

import your 

Mendeley library 

into Zotero here.

If you’ve got manual lists of references, maybe from previous 
drafts or publications, which you’d like to import as citations 
in Zotero, head over to https://anystyle.io/.  

Copy and paste your bibliography in the space provided, 
follow the instructions to parse the data, and save the output 
as a BibTeX file. 

Next, head to Zotero. Select File > Import… > and follow the 
instructions to upload your file – just like magic, the citations 
will appear in your library instantly!

Rachel Berryman
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FREQUENTLY ASKED Q’S
THIS ALL SOUNDS GREAT! CAN I INTEGRATE ZOTERO 
WITH MY WORD PROCESSOR OF CHOICE, SCRIVENER?
Unfortunately, there isn’t an official Zotero plugin for Scrivener. 😢

However, you can check out this guide from Cornell library which lists a number of 
workarounds for those who would like to use both programs!

Photo 
Credit: Scrivener
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https://guides.library.cornell.edu/zotero/scrivener
https://www.literatureandlatte.com/scrivener/overview


FREQUENTLY ASKED Q’S
I’ve got so many items, I’ve run out of storage 
space in my zotero library! 
You’re in luck! While each account comes with 300MB of free cloud storage, Zotero 
has tiered options for those looking to increase their storage capacities. 

Head over to https://www.zotero.org/storage to find out more.
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Thank You!
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If you’re interested in discovering more tools and resources 
created by the D/ARC, head to darcmode.org


